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Why Use Pro Tools ? 
 
Pro Tools Academic is a special low-cost version of Pro Tools targeted at education. 
It’s made, marketed and supported by Sibelius and M-Audio in North America. 
Technical support on this product is available by calling (650) 731-6100. 
 
Training courses are available: contact Ken Johnson at Sibelius/M-Audio for details 
(kjohnson@m-audio.com) or visit www.protoolsacademic.com for details. 
 
Movies are also available on that website, which cover many features in this guide as 
well as documents that cover commonly used key commands and microphone guides. 
Just visit http://www.sibelius.com/helpcenter/hintsandtips 
 
Pro Tools is the widely accepted “industry standard” for all kinds of audio editing on 
your computer. Allowing students the chance to learn and use this software will vastly 
increase their chances of progressing in the audio and broadcast industry. 
It also allows teachers to manipulate recordings of their ensemble, and it provides the 
backbone for film composition, audio recording or broadcasting courses. 
 
At a price point starting at $249 for a complete software/hardware solution, price is no 
longer a factor that should prevent schools using Pro Tools. It’s ideal for students in 
higher education also. 
 
There are two actual versions of Pro Tools Academic: the stand-alone version (which 
needs an iLok key) works with nineteen different M-Audio devices, and the Pro Tools 
Academic that is supplied with hardware. This guide is primarily focused on those using 
Pro Tools Academic with supplied hardware: we recommend one of these below as your 
choice of hardware. 
 
Mobile Pre – This is a small interface that records up to two signals at a time.  It has two 
microphone inputs (XLR) and two instrument inputs (TRS). It connects to your computer 
via USB and doesn’t need its own power supply. Phantom power is supplied for 
condenser microphones. 
Ozone Academic – A portable MIDI keyboard that includes a microphone or line 
instrument-recording jack. You can playback your song through the audio outputs on the 
rear of the keyboard. Extra knobs on the keyboard will control features in Pro Tools. This 
is a complete solution for MIDI input and audio recording/playback. (Phantom Power) 
  
Other suggested equipment – you may need some or all of these to complete your studio: 
 
We can provide more details on all of these items, and pricing: 
Microphones (we suggest the M-Audio NOVA or SOUNDCHECK condenser mics) 
Speakers (we suggest the M-Audio DX4 or BX5 series of speakers) 
MIDI keyboard (if you don’t already use the Ozone Academic keyboard): there are many 
choices of keyboard available: we recommend the M-Audio KEYSTATION, OXYGEN, 
02 or OZONE keyboard. 
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MIDI sound source: if you want to use a regular General MIDI Sound Set with Pro Tools, 
you might want to get a MIDI keyboard with built in General MIDI sounds 
Control Surface: This is a dedicated mixing board for use with Pro Tools Academic that 
interfaces directly with the software and simply replicates many of the functions you see 
on the screen: we recommend the M-Audio Project Mix I/O.  A control surface provides 
moveable, tactile feedback for control of all software functions with Pro Tools. The 
Project Mix I/O also doubles as an expanded system for recording audio sources. 
Additional hard drive: Unlike notation, audio files are fairly large files. You should allot 
a proper space for all the recorded files to avoid filling up your hard drive. As an 
alternative, you can use an external storage device for your audio files. These kinds of 
devices usually connect via USB or Firewire, and are very affordable. 
 

Hooking Up Your equipment (Windows or Mac) 
 
Pro Tools Academic requires windows (running XP second edition) or Mac (running OS 
10.4.3 or later). The latest version is 7.3, which also supports new Intel Macs. 
As ever, with software, it’s always good to run the latest version: if you need to upgrade, 
drop us an email and we can tell you how. If you regularly update your operating system, 
on Mac in particular, don’t run software update. Instead get the combo update from the 
Apple website instead, or else Pro Tools might cease functioning. 
 
The product comes with several discs: some contain DRIVERS (which allow your 
computer to function correctly with hardware attached to it), and some contain 
TUTORIALS, including complete documentation, and the program itself has its own 
disc. This guide is an addendum to those things. 
 
You’ll also get EXTRA discs with additional software and utilities on them, which you 
don’t have to load, such as Xpand (an excellent software synthesizer) and BFD (an 
excellent drum loop and drum playback device). Feel free to load them and try them out 
too. Remember, if you just install Pro Tools Academic without the extras like Xpand and 
BFD, it does not come with sounds of its own, nor will it play through the MIDI 
soundcard on your computer. In short: if you want sounds, you’ll need to install Xpand 
and BFD. Why not, you already paid for them! 
 
To install the program, CAREFULLY read the paper documentation that comes with the 
product (Getting Started, Chapters 3 and 4). If you have problems, call tech support on 
(650) 731-6100. 
 
The recommended order in which you do things is as follows (and don’t try and run the 
software until all this is done): 
 
Load Pro Tools Academic first (from the installer disc) 
Load the DRIVER that came with your hardware (Mobile Pre or Ozone Academic). This 
is an AUDIO and MIDI driver, which allows your computer to use the M-Audio 
hardware for your MIDI and Audio. 
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You’ll only need a USB cable to connect the Mobile Pre or Ozone Academic to your 
computer: Windows users note: always dedicate the same USB port to use on your 
computer, in case windows gets confused if you switch to using a different USB port. 
Take a look at the flowchart below, which might also help you: 
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Finding Your Way Around – Audio & MIDI 
 
 
 
 
 
 
 
 
 
 
1 Before you start, you might want to grab some audio to use in Pro Tools from a 
CD or from iTunes (like a song). Typically sound waves are stored as WAV, AIF or MP3 
(and also AAC, or MP4a) files. Make sure you’ve got a song or a piece of audio ready to 
use on the desktop of your computer, or if you prefer, you can start recording straight into 
Pro Tools. 
 
2 Each time you run Pro Tools, it will search for the required hardware device as it 
loads, so ALWAYS make sure your hardware device is attached first, otherwise Pro 
Tools will fail to load. Switch on the power first on the Ozone Academic keyboard if 
you’re using that. The Mobile Pre is automatically powered by connecting it via USB. 
 
3 Some terminology before we start: 
Every time you start a new song in Pro Tools, that’s called a SESSION, and has the file 
extension PTF. In the same folder, it saves other important information, such as the actual 
sound waves (always referred to as AUDIO) and other information about your song. As 
you go, you’ll be creating TRACKS and you can “chop up” these tracks into areas called 
REGIONS. 
 
4 When you first open Pro Tools, no session is loaded, and you should start a new 
session. Give it a name, plus remember WHERE you’re saving it. The screen looks like 
this: 
 
 

 
 

Throughout this guide we will refer to several important keys on Mac and 
Windows keyboards. On Mac, the Command key“⌘” key is labeled with “⌘” 
On Windows, the “Start” key is between the control and alt keys. Most functions 
in Pro Tools have a shortcut, which is often a combination of ⌘, option, shift and 
other assorted keys… 
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5 You’ll see a timeline running along the screen, with various icons at the top of the 
window: you can customize this: see the later section. There are no tracks in your session 
yet, just a blank edit window. Tracks will appear below your timeline as they get added. 
 
6 Pro Tools allows you to drag and drop an audio file straight onto your new 
session, even if you haven’t created any tracks. So now you might need to resize your Pro 
Tools screen so you can see “behind” onto your desktop. Don’t turn off Pro Tools. Find 
the audio file you want, then drag and drop it onto the space below the timeline. A dialog 
box may appear at this stage: click OK. 
After a few seconds, you’ll see the audio track appearing, and you can tell it’s audio 
because of the waveform, which has this characteristic look:  
 

 
 
7 Before playing the audio back, let’s move the audio around a little. Since your 
audio file might be longer than your screen can display, there’s a scroll bar at the bottom 
of the screen, which you can use to move through the track. 
If the audio didn’t appear at the beginning of the track (i.e. the left hand side), you should 
be able to freely DRAG the audio from left to right. Hover your mouse over the audio 
waveform until a small hand appears, then drag. Make sure the word SLIP is highlighted 
in the top left corner of the Pro Tools screen before you do this. 
To play the audio track from the beginning, you should just be able to touch the 
SPACEBAR. Touch it again to stop the track playing.  At the top of the screen you’ll see 
this:  
 

 
 
You have choices about whether to view Minutes and Seconds or Bars/Beats: click the 
down arrow of the “Main” line to change your display. There is also a floating window  
(Called the transport) at the bottom of the screen, which copies the same view. The 
window should be set to Mins/Secs for audio, but if you’re working with MIDI, more 
likely you’d use Bars/Beats. 
 
8        When you are playing back your track, get into the habit of not using the space bar 
and instead, use the numeric keypad for all of your CD style controls. 
Use the following keys on your numeric keypad to control: 
 
Stop   Numeric Keypad 0 
Play   Numeric Keypad 0 
Rewind  Numeric Keypad 1 
Fast Forward  Numeric Keypad 2 
Record  Numeric Keypad 3  
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9 One other nice feature is the ability to playback a section of your song in a 
loop/cycle. 
To do this, you need to turn loop playback on, via the options menu at the top of the 
screen, and select “Loop Playback”, alternatively you can turn this on with the shortcut 
(⌘ Shift L on Mac) or on Windows: Control Shift L (i.e. hold down the two keys, then 
tap L, then release your fingers). 
To choose the section you wish to loop, simply highlight a region and press play. Your 
selection will automatically loop.  
Please remember than when you are done looping, you should turn loop playback off. 
 
10 If you don’t hear the track playing, now’s a good time to check out your MIXER 
window, which controls the volume for the track. 
Choose Window>Mix at the top of the screen. The shortcut Control = (⌘ = on Mac) 
should bring all your windows into focus. 
 
 

 
 
Your audio track should have a long “strip” with a fader at the bottom. 
Half way down, it says IN and OUT. Hopefully it’ll say IN 1-2 and OUT 1-2. Press your 
mouse on each button to expand your further choices. 
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Your outputs are chosen automatically, and there’s no need to alter them. The fader will 
affect the overall volume level of the audio, and there’s S (solo), M (mute) and panning 
(Left/Right Placement) controls there too. 
 
11 Going back to the Edit window now, we can change the appearance of the track 
too, perhaps to make it easier to read. Let’s RENAME it. Double click where the track 
name is (In the shot below, it’s titled “Track 1”) Rename it in the box that appears, and 
click OK. 

 

 
 
You’ll also see the word “Waveform” nearby. Click on the arrow to the right of that word 
(not the word itself), and you’ll see choices appear to make the wave appearance much 
BIGGER. Experiment with the different settings. Leave it set to jumbo for the moment. 
You can zoom in on the wave by typing Control  [ ] (⌘  [ ] on Mac). Those are the 
square brackets to the right of the P key. It will center what is currently displayed, so you 
may need to scroll through the wave to see what you want. You can zoom to a very high 
resolution if you need: great for editing. Don’t forget to zoom back out. 
We’ll also do something with the ZOOM buttons at the top of the screen: 
 

 
 
You’ll see an option to zoom in and out of the audio, with 5 presets to choose also. The 
shortcuts to do this are Windows Start Key + 1, 2, 3, 4, 5 (Control + 1,2,3,4, 5 on Mac). 
Use the numbers above the QWERTY keyboard.  
 
 
 
 
 
If you want to play back your audio from a certain place (not the beginning), click on the 
audio where you want to start playing, and a blinking black line will appear. Press 
SPACEBAR. To stop playing, press spacebar again, and the line retains its position. 
 
12 We’ll cover editing audio in the next section, but let’s quickly take a look at MIDI 
as well. Skip this section if you want to concentrate on audio only. Save the work you’ve 

HINT: you can always see what a button does in Pro Tools by holding your mouse over 
it. A display will appear with a label for each control. 
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currently been doing. For this section, you’ll need to have a MIDI keyboard or a sound 
module connected to your computer, so first turn off Pro Tools (and leave your hardware 
device connected).  
Connect a MIDI keyboard or sound module (one with onboard sounds) to your computer, 
perhaps with a USB to MIDI cable like the M-Audio UNO. Make sure the driver is 
loaded, and that the device is already recognized by your computer before you go further. 
You should have another USB port to use for this. If you have the Ozone Academic 
keyboard, however, this has MIDI OUT on the back, so you can just connect it to a 
keyboard or module with sounds using a regular MIDI cable. 
Then see if you can find a MIDI file on your computer. If not, then download a MIDI file 
from the Internet. There are plenty of free resources available. Make sure you can find 
one easily, and put it on your desktop. 
Then open Pro Tools, start a new session and drag your MIDI file onto the blank edit 
window, and a dialog box will appear like this: 
 

 
 
 
Check the boxes that say “Import tempo map” and “Import Key signature”. Your MIDI 
file should appear in a new track within Pro Tools. 
 
13 If your MIDI file had multiple tracks in it, each one should now appear in your 
edit window. If the tracks already had names, they will appear too. The MIDI data will 
look a little different from audio, because it doesn’t represent sound waves. It’s just a set 
of instructions, or EVENTS.  
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The first thing to see is if the MIDI file will play back. We need to look at the Mix 
window (window>Mix). You’ll need to choose an OUTPUT for each MIDI track, if one 
isn’t selected already. If you have an external MIDI device connected using the M-Audio 
UNO cable, choose that from the list. If you have something connected with a regular 
MIDI cable to your Ozone Academic, choose that as your output device. 
If you don’t have a sound source, your MIDI file won’t play! It won’t play through the 
soundcard of your computer. 
 
14 Now let’s select one of the tracks by clicking on it. Go to Event>MIDI Event List 
(shortcut is Alt = or Option = on Mac). All the events in that file should be listed. You 
can later manipulate all that data, and you can also add new audio and MIDI tracks into 
your song. This is how you would add a live vocal to your Sibelius file, for example: 
export your Sibelius file as a MIDI file, bring it into Pro Tools and then add new tracks. 
You can mix audio, MIDI and Instrument tracks together. You can also DRAG the MIDI 
data around and edit it (see later section on this). 
 
15 You now have enough knowledge to manipulate Audio and MIDI, but let’s define 
the additional tools, which you may or may not need to use in Pro Tools Academic. Take 
a look again at the picture in step 4 above. 
There are four main Edit MODES in the software, accessed by using the function keys F1 
to F4 on your computer. You’ll see them in the top left of your screen:  
Shuffle mode: use this when you want to chop up audio and not leave any empty space 
Spot mode: for precision editing and moving of audio and MIDI 
Slip mode: think of this as your “standard” mode to be in all the time 
Grid mode: when you want to “snap” regions to a pre-defined position, usually based on 
bars and beats: use it for synchronizing audio and MIDI data together so they line up.  
 
16 ZOOM controls: there are four buttons: hold your mouse over them to see what 
they might do, and experiment with them. Please note that there’s a different vertical 
zoom for MIDI and one for Audio. 
 
17 TOOL palette: you will see six buttons here, and three of them should currently 
be lit up simultaneously. Tap the Escape key on your computer to cycle round, and you’ll 
see that there are seven choices in total. For most work in Pro Tools, leave the three 
buttons lit up: they’re called the SMART TOOL. They will allow you to do most things 
you need. Hold your mouse over each of the six buttons, and you’ll see a description of 
what each one does. 
 
For a thorough description of what each tool does, refer to your Pro Tools documentation, 
which came on a disc with your software. There’s also a tutorial DVD that comes with 
Pro Tools Academic, which you may care to watch. 
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Editing Existing Audio 
 
To begin editing audio, you should have some audio in place on your edit window for 
manipulation. We’re going to cover the most frequently used tool for audio editing: The 
Smart Tool. 
 
 
 
 
 
1 The Smart Tool: The smart tool consists of three individual tools combined into 
one. The tools are as follows: Trim Tool, Selector Tool and the Grabber Tool. What 
makes this tool “smart” is that it changes its function, based on where your mouse is in 
relation to the audio waveform. Even though the smart tool combines three individual 
tools into one, there’s no practical reason for using the tools individually. The smart tool 
is clever enough to know what you want to do, based on where your mouse is positioned. 
 
2 The Trim Tool (visually resembling a C-shaped bracket) allows you to mask the 
audio at the beginning or the end of your waveform, removing silence or noise before 
your start playing.  
 
3 The Selector Tool (visually resembling a capital letter I) allows you select a part 
of your region and cut it out, allowing for re-takes and precise edits. 
 
4 The Grabber Tool (visually resembling a hand) allows you to reposition the 
region anywhere in the timeline that you choose. The effect of your grab depends on 
which editing mode you are in. We suggest staying in slip mode for all of your editing 
within Pro Tools. Please note that if you are working with STEREO audio, the grabber 
tool only activates when you are in the lower portion of the audio (i.e. the right channel). 
 
5  Using the Smart Tool: The smart tool changes its function and appearance, based 
on where your mouse is in the region you’re editing. For example, if you’d like to trim 
the start of your region, to eliminate some noise before your recording, scroll to the start 
of the region and hover your mouse along the far left edge. You will notice the cursor 
become a TRIM tool allowing you to now click and drag the start point of your region to 
the right, masking unnecessary audio as you go.  The beauty of this method is that 
masking audio does not actually delete audio. It is a non-destructive. Moving your mouse 
to the far right hand section turns on the trim tool for the end of the region. 
 
6 Using the Grabber Tool: (hand tool): hover your mouse along the lower portion 
of the waveform, typically someplace in the middle of your screen. You will see the 
appearance of the tool change to the hand when you’ve reached the correct spot. Clicking 
and dragging at this point will move the region to the right or the left. 
 
7 Nudging: Sometimes the hand grabber might not be precise enough when you 
need to move audio very slightly, so instead select the audio and use the + and – keys on 

A region is automatically created when you record or import audio of 
any type. Every block of audio in Pro Tools is considered a “region”. 
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your numeric keypad. The NUDGE section of your toolbar controls the amount by which 
the audio moves. If you’re set to mins/secs, the audio will move in seconds, but you can 
change the resolution of this:  
 

 
 
 8 At all other times the cursor is the selector tool, shaped like a capitol I. This 
allows you click and drag, creating a highlight of a section that you can delete with the 
delete key.  
 
 
 
 
 
9 Markers: If you want to divide up your recording into sections, placing non-
destructive markers is the best way to go. To add a marker, select the correct place in the 
audio by clicking in your region – this will place a vertical line in the audio. To add a 
marker, press enter on your numeric keypad to bring up the add marker box. Name the 
maker point and press OK. Markers will show up in your timeline as small orange tabs. 
Click on them with your cursor to go to the exact marker position. This is ideal for 
showing song structure to students and quick recall of exact spots in your audio. 
 
10 Scrubbing: One very useful way to find an exact spot in your audio region is to 
“scrub” across the audio, much in the way you’d physically move a reel-to-reel tape back 
and forth. Scrubbing lets you listen to the audio as you drag your mouse over the region. 
To engage the scrub tool, on windows, press Start, and drag the mouse back and forth to 
scrub (Control-Drag mouse on the Mac).  You will see the cursor change shape, and 
you’ll hear the audio as you move your mouse back and forth. The faster you drag your 
mouse, the faster the audio flies by. 
 
11 Fades: At the start and end of your recording, it’s commonplace to fade-in and 
fade-out the audio for a smooth transition from music to silence and vice-versa. Try 

HINT: You can always use Control-Z (⌘-Z on Mac) 
to undo any actions in Pro Tools. 
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adding them to your audio now. Fades are found in the edit menu, however in order for a 
fade to work, you must select the audio you wish to fade. Use the selector tool to 
highlight a few seconds right at the beginning of your audio, and use the shortcut 
Control-F (⌘-F on Mac). When the fade window appears, press OK and your fade is 
automatically created. Try this right at the end of your piece as well.  
 
 
 
 
 
12 Regions Defined: When you first import or record audio, it creates a single 
region. If you edit, add other audio, or in general, chop up your track, extra regions will 
be created. Take your existing audio track, select a point with your cursor, and type 
Control + E (⌘ + E on Mac). You will notice immediately that the new region has been 
named in the top left hand corner. 
 

 
 
 You can now drag that region to the right using your grabber (hand) tool. Create as many 
regions as you like, if you are planning to chop up something like an audio speech, or edit 
your audio into sections to work on. You can view all the regions in your song, and easily 
access them at any time by locating the small icon at the very bottom right corner of your 
Pro Tools screen. Click there, and the region list appears. Click on any of the regions in 
that list, and all the audio in that region is highlighted. 
 
There’s an important benefit to using regions. If you decide temporarily not to use a 
region, you can delete it from the track, but it will NOT be deleted from your session 
forever! This means you can later retrieve it or use it again – ideal for a chorus vocal that 
you want to repeat later in your song without re-recording. Regions are very easy to copy 
and paste back into your track: just click and drag from your region list! 
 
 
 

Pro Tools automatically knows to fade-in at the start and fade-out at the end of 
a region. Clever! 

Hint: Get into the habit of always naming your regions, so you can identify 
them easily later on: double click on the region name to edit it. 
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New Audio - Stereo & Multi Track Recording 
 
1 Start a new session in Pro Tools. Type Control/Shift N (⌘/Shift N on Mac), and 
your first decision is what kind of track you want. 
The choices are here: 
 

 
 
The main choices are obvious: is the track mono or stereo, and is it Audio, Video, MIDI 
and Instrument (choose this if you want to use the sounds inside Pro Tools, like Xpand, 
assuming you have installed them). Occasionally you might use the other types of tracks. 
This section will require you to choose an audio track, probably in mono.  
 
2 Setting Proper Levels: When recording into Pro Tools, it’s essential to set your 
input levels correctly. When you record into Pro Tools, your signal undergoes a 
conversion from an analog waveform to digital bits. While Pro Tools provides you with 
faders to control your level inside the computer, this only works if you bring the proper 
level into Pro Tools. This is done on the physical interface itself (Mobile Pre / Ozone) 
and not in software.  
 
When you record-enable a track, Pro Tools will allow you to visually meter the incoming 
signal, which you’ll need to watch as you work. However, you need to adjust the physical 
input knobs on your hardware. It’s easy to remember: When recording, tweak the plastic 
knobs on your interface. When mixing, tweak the software controls! 
 
Digital signal theory is very simple: You mustn’t hit the red. Each meter reads back 
incoming signal on a scale of 0dB being the very loudest signal and -96dB being the very 
softest. You simply shouldn’t exceed 0dB on input. This is easy to avoid and impossible 
to fix after the fact. Simply position your microphone or other sound input device and 
enable record mode in Pro Tools. Watch the input meters. Play what you feel is the 
loudest sound in your piece, and watch the meters. Visually it will hit red if you go too 
high, but the bottom of the strip also shows you a numerical readout. You should aim for 
about -6dB when you record. Remember, you can raise the level to your heart’s content 
in software, but if you exceed 0dB on input, you will “clip” the waveform and ruin the 
recording. There is literally NOTHING you can do to help a poorly recorded 
performance. 
 
Recording a clean, pure signal into Pro Tools ensures that you’ll be able to add effects 
and mix to a final, polished, professional sound.  
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3 Now to the actual nuts and bolts of recording. You might want to think about the 
TEMPO of your song if you’re going to add multiple tracks. (If you’re capturing a live 
ensemble piece, this perhaps doesn’t matter). Also, if you might later be likely to add 
MIDI, or drum loops or anything that is more tempo-specific, though, having a CLICK 
track to record with will be vital. Pro Tools can generate an “internal” click track by 
going to Track>Create click track. It automatically creates a track with its own fader if 
you need it. You’ll hear it when you start recording. 
 
4 Next, plug-in a mic or an instrument into your hardware device. 
Remember WHICH input on the device you’re using. If you’re using a microphone, two 
vital things to remember: always turn the speakers OFF and use headphones (or else 
you’ll encounter FEEDBACK), and secondly, if it’s a condenser mic, you’ll need to 
activate the PHANTOM POWER on your Mobile Pre or Ozone Academic keyboard. 
 
5 If you already created a new mono audio track in your song, go to the Mix 
window, and check that your choice of INPUT source matches the input you’ve chosen 
on your hardware. 
Arm (record-enable) the track, by touching the RED button. At this point, you should see 
a signal coming in, and be able to check your levels (see previous section above). You 
will also be able to hear yourself, or “monitor” the incoming signal. If you’re using extra 
hardware for your guitar, like your own sound equipment, plug the guitar into that first, 
then into the Pro Tools hardware, but remember you can also add effects later. 
 
 
 
 
 
 
 
6 Some people like to record their vocals/audio with reverb, to improve the 
performance. You can set up an Aux input (see the section in this guide on using audio 
plug-ins for how to add reverb to a mix), and send the vocal signal to a reverb plug-in, 
but the great thing is that you won’t be recording the reverb: it’ll just be present in your 
headphones: you can formally add it later on in the final mix. Try not to add too many 
extras into the loop when you’re recording, though, unless it slows down the computer. 
 
7 Takes: A powerful feature in Pro Tools is the ability to record multiple “takes” or 
“performances” within the same track. This is useful for recording a difficult section 
many times and picking the best one. To create a take, in the Edit window: click and hold 
on the up/down arrows directly to the right of the track name and select “new”. A dialog 
box will appear for you to name the new take (please name them intelligently). Creating a 
new take will clear the track and allow you to record new audio. You can do this as many 
times as you need. To recall an old take, select the same arrows and you will see a list of 
all of your saved takes. Select the one you want, and it appears in the track. 
 

Watch the Red: In the mixer, each meter has an overload light 
which glows red when you have clipped the input. The red light 
stays on until you reset it. To reset it, simply click on the light 
and adjust your levels so the red light never comes on. 



Pro Tools Quick Start Guide: April 2007 16 

To work with a smaller section, you may want to “duplicate” the current take and edit 
only a small portion of the audio. Following the manner above, select “duplicate” and 
rename your take. Go ahead and edit the offending section and rerecord new audio. The 
old take is accessible in the same way: go to the up/down arrows, select the old take and 
it will reappear. It’s typical in classical music to have many takes, especially with 
challenging sections.  
 
8 Punch Recording Pro Tools can "automate" the action of pressing the record 
button for you, through a process called "Punching Recording". This is helpful is 
a variety of situations, such as: recording by yourself and not having a free hand to 
operate the software and play your instrument, and correcting a small spot where you 
have to record only a few bars and leave record mode quickly. Set this up using page 
176 in your "Pro Tools Reference Guide" included with every Pro Tools Academic 
system. 
 
9 One final hint: make sure you have enough HARD DRIVE space on your 
computer before you start any project! Investing in a separate, large hard drive to 
“archive” your projects is pretty much an essential purchase! 
 
10 Most songs start from the “ground up”: i.e. the basic rhythmic tracks first, then 
gradually add the melodic and harmonic content. The click track will be critical to help 
you. Create as many audio tracks as you need. There’s also nothing wrong with creating 
“guide” tracks that won’t later be used: like an ultra simple chord progression with basic 
rhythm that helps “guide” everyone else later. 
 
11 Latency: When you record in a computer system, there is a slight delay for the 
signal to go to the computer and come back to your monitor. This is called “latency”. At 
first, it will take a bit of getting used to. The amount of delay is in the millisecond range, 
but can still be unsettling to many at first. To completely alleviate latency, use a hardware 
mixer and monitor your session through that. If you intend to record with effects, you 
will have to accept some latency. Both the Ozone and Mobile Pre have settings for low 
latency. Please refer to the Pro Tools documentation on how to adjust the “buffer” 
settings to decrease latency as much as possible. 
 
12 Once you’ve got your first track down, simply add more tracks to your song and 
build it up from there. You can add MIDI and Instrument tracks too. One other minor 
point, for safety’s sake: If you look at each track in the Mix window, it has an input and 
an output. Once a track is recorded, you can actually turn off the input entirely, and just 
leave the output. Audio tracks will be blue in the mix window. MIDI tracks will be 
purple. If you created a click track, that will also have its own fader, and it will be 
colored green. 
Don’t forget to use MARKERS in your song to help you find your way around! These 
are discussed earlier in this guide (page 12, step 9).



Using MIDI & Instrument Tracks 
 
1 Recording MIDI data into Pro Tools in not a great deal different to audio, except 
that MIDI data itself is not sound waves: it’s a set of instructions for some device for 
what notes to play. See configuring Pro Tools earlier in this guide, if you need to hook up 
a MIDI device. If you’re planning to record MIDI data or playback MIDI data using 
“conventional” GENERAL MIDI sounds, you’ll need to have a keyboard or sound 
module with its own sounds that you can use. 
 
2 Pro Tools, however, comes with at least two great sound sources: Xpand (a 
software synthesizer instrument) and BFD Lite (a software instrument for playing drums 
and percussion grooves). If you’re using those sounds, you’ll be creating an 
INSTRUMENT track in Pro Tools, rather than a MIDI track. So think of instrument 
tracks as being somewhere BETWEEN the concept of Audio and MIDI. They respond to 
MIDI data, but they play back using sound/audio. See step 16 onwards (below). 
 
3 For standard MIDI recording, start a new session in Pro Tools Academic, and 
create a MIDI track. You might want to ensure that your main transport window at the 
top of the screen is set to display BARS/BEATS rather than MINS/SECS (a better default 
for using MIDI data). If you know the tempo you need already, change that too: you can 
do this from the floating transport window. If that window isn’t on your screen, type 
Control/⌘ + 1 on your numeric keypad to see it. 
 
4 Go to the Mix window (your MIDI track will most likely be purple at the top), 
and ensure that its output is routed to your MIDI playback device (if you have one). If 
you don’t have one, skip this section, and create an Instrument track instead (see step 16). 
If you have a MIDI keyboard, it should be connected to your Ozone Academic keyboard 
(if that’s your hardware device), or (if you’re using the Mobile Pre), it should be 
connected using a separate USB to MIDI cable: choose whichever you have. The sound 
output of your MIDI device can be connected to the audio input of your Ozone or Mobile 
Pre, or (if you prefer) you can simply connect it straight to your speakers. 
 
5 You’re almost ready to record some MIDI. You might want to create a MIDI 
click track too, so you can tell bars and beats. Go to Setup>Click, and a dialog box 
appears: ensure that you’ve chosen an OUTPUT for your click track (so you can hear it!), 
and make sure the click is on MIDI channel 10 (drums). 
 
6 Now choose the SOUND you want for MIDI: in your MIDI track’s settings (in 
the edit screen), you’ll see the word NONE: click on that, and choose a MIDI sound 
number: 0 is piano, for example, and 53 is voices (refer to a list of general MIDI sounds 
to discover which sound uses which number – there are 128 to choose from).  
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7 Record enable the MIDI track (the R button in the track box), make sure you’re 
NOT using loop layback (Options>Loop playback should not be checked), press the 
record button on the floating transport window, then press play (or spacebar) to begin 
recording. Play some notes on your MIDI keyboard. Press spacebar or stop. MIDI Data 
should have been recorded, which you’ll see. If you don’t see notes, check the settings 
described earlier. 
 
8 To HEAR BACK your MIDI, first ensure that your main cursor is set to be the 
standard SMART TOOL (see earlier in the guide), click somewhere in the timeline, and 
press play. 
 
9 Quantizing (cleaning up inaccuracies) is an important feature of MIDI recording: 
you can do it before or after you record. Go to Event>MIDI>Grid/Groove Quantize to see 
the settings you can change. 
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If you’d like to quantize as you play into Pro Tools, in the same Event>MIDI menu, 
you’ll see “Input Quantize” which will bring up the following window: 
 

 
 
Make sure to check “Enable Input Quantize”, and select settings that relate to your 
upcoming note input. Keep in mind that you can change these values at any time. 
 
10        Selecting and editing MIDI data: you might want to make the track get bigger 
(covered earlier in the guide: choose JUMBO or EXTREME). You’ll also notice a tiny 
piano keyboard appears just before the MIDI track data starts, so you can tell high and 
low pitches.  
 
In order to move/edit the MIDI data you now have with your smart tool (like you can 
with audio), go to your MIDI track and change the view from “NOTES” to “Regions” by 
clicking where it says “NOTES” in the tracks info panel. When you click, you’ll see a 
bunch of choices, and regions is the choice one you want. 
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When you’re making selections/edits of the MIDI data, you should have the SMART 
TOOL selected, and you should be able to click and drag to select the data. All of it gets 
highlighted. The Smart Tool was discussed earlier in this guide. 
You now have choices. Move your mouse towards the lower portion of your MIDI data, 
so it looks like a hand, hold down Alt (Option on Mac), and drag the data to make a copy 
of the same data a little later on in the track. You can make all the data’s pitch changes if 
you drag the data slightly up or down. 
 
11 On other piece of advice: when editing MIDI you might want to have GRID mode 
selected (top left of the Pro Tools screen), rather than SLIP mode, since you might want 
the data to “snap” to a more accurate place later in the song, rather than a random place, 
which will happen with SLIP turned on. Type F4 to select it. 
 
12 You can view the MIDI data in various other ways: turn on the EVENT EDITOR 
from Event>MIDI Event List – shortcut is Alt = (Option = on Mac), and you can make 
many minor adjustments to specific notes inside there. MIDI data, including notes, tend 
to be called EVENTS. 
 

 
 
13 Also in the MIDI track itself, on the left hand side, where it now says REGIONS, 
you can click to change this setting to show VELOCITIES or VOLUME, and make edits 
with your mouse (keep the Smart Tool turned on).  Velocities cover the actual volume 
levels of individual notes in a MIDI track. Volume is more like the master volume of 
everything. Changing the volume or velocities is just like creating a FADE with audio 
tracks (and it works exactly the same way).  To create fades, here’s a moment when we 
STOP using the Smart Tool. Activate the pencil tool at the top of the screen (the one with 
the pencil icon), and click some marker points onto the volume line with the pencil tool 
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These can be moved and adjusted to create a smooth fade. If you chose to edit velocities 
instead, click and drag the pencil tool over the events, and see what happens! 
 

 
 
14 For multi track MIDI recording, keep adding more tracks of MIDI and following 
the same steps as above. As a general rule, try and avoid more than 16 tracks of MIDI, 
since your sound playback source may get confused. There are officially only 16 MIDI 
channels: each track should use a different channel! Drums are reserved for channel 10 in 
a standard MIDI set up. 
 
15 MIDI Zoom: In Pro Tools, there are two different zoom tools available on the top 
bar. One controls the zoom of audio exclusively and the other exclusively deals with 
MIDI. When editing MIDI, it’s useful to zoom in for a better look. You’ll want to press 
this button to zoom in and out of the MIDI regions in your project. 
 

 
 
16 Working with Instrument Tracks in Pro Tools is pretty similar to MIDI when it 
comes to editing the music you create, but it has some set-up aspects mighty similar to 
working with audio. We’ll work with an instrument called Xpand first of all, which is the 
standard software instrument supplied with Pro Tools Academic. 
You’ll need to have a MIDI keyboard attached to Pro Tools to work efficiently. This 
guide assumes you have the Ozone Academic Keyboard attached as your hardware 
device. 
 
17 Instrument tracks require you to “wire up” a virtual instrument to them before you 
can choose the sounds you need, unlike simply creating a MIDI track with patches you 
can choose. Xpand comes with lots of sounds, and you can layer up to 4 sounds at once to 
create really interesting sounds! 
 
18 Create a new mono instrument track. Double click on its name and rename it if 
you wish. 
We have to use Xpand as an INSERT EFFECT on the instrument track.  
The section in this guide called The Basics of Mixing explains more abut this concept in 
diagram A. Read that too!  
Open the Mix window, go to the INSERT area of the (orange) track, and choose plug-
in>Instrument>Xpand (mono).  
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The Xpand plug-in window will appear: more on that in a minute. Drag that window out 
of the way if its obscuring your view, but don’t close it. 
 
19 We need to ensure that playing on the Ozone keyboard will trigger Xpand’s 
sounds. 
Still in the Mix window, hold your mouse over the first button below the orange strip. It 
says ALL at the moment. It’s good practice to specify a MIDI channel to use, so click on 
this, choose Predefined>Ozone Academic Port 1>channel 1. Try holding down some 
keys on your MIDI keyboard – you should now be hearing the “Shimmer” sound which 
Xpand chooses by default. 
 
20 To select sounds in Xpand, go to the Xpand window, and click on the little down 
arrow at the right hand side of the black panel that currently says “Shimmer”. Many 
choices appear, including drum loops and grooves, which are often a good starting point 
for a track!  
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Experiment with what you want. At this moment, you’re choosing which sound you want 
in part A of Xpand.  If you wish, you can go to parts B, C and D of Xpand, and start 
layering more sounds to go with the one you chose for part A. There’s volume sliders to 
control the overall mix you want to hear. 
 
21 When you’re ready to record something, you might want to set up a click track, so 
you can hear the timing/speed of the song whilst you record (and make sure that your 
song is playing at the same speed as your drum groove, if that’s what you choose in 
Xpand). You can either use the MIDI click discussed earlier, or (just as easy) Pro Tools 
can supply one for you. Go to Track>Create Click Track, and Pro Tools immediately 
generates an extra track in your song, which you’ll hear when you record. It has its own 
volume slider. 
 
22 Two other things worth remembering: it’s a good idea to experiment with tempo 
before you lay down your masterwork. If you record something and don’t want to keep it, 
undo always works: Control/⌘ Z is the shortcut. 
 
Also, remember that what you’re recording is MIDI data, which can be manipulated in 
different ways than audio. You might want the main MODE of Pro Tools (top left hand 
corner) to be set to GRID, and you might want the main transport controls to be 
expressing everything as BARS/BEATS. Go to that window and use the down arrow to 
change that setting. 
 
23 Edit your data in the same way as explained with MIDI data (see above). Don’t 
forget also, that because you’re not dealing with audio, you can continue to change 
sounds in Xpand AFTER you’ve recorded your notes, since it’s just data at this point, not 
sound waves. 
 
24 If you need more Xpand sounds in your song, you’ll need to create extra 
Instrument tracks, and follow the same steps explained above, but obviously choose 
different sounds in Xpand! 
 
25 If you’re into more choices of drums, try playing around with BFD Lite in Pro 
Tools too! That’s a fantastic software instrument for creating groove tracks, and you can 
create separate instrument tracks that will use that instead of XPand. There are great 
tutorial videos that come on the BFD disc, showing you how to make the most of BFD 
Lite. 
 
26 If you happen to use OTHER SAMPLE PLAYBACK ENGINES, such as 
Kontakt, and others, make sure they are Pro Tools compatible (Which is identified by the 
term “RTAS” compatible, and load/use them in much the same way as above. Refer to 
those products’ documentation.  
 
Finally, of course, you can add real audio tracks to your song too! They can happily sit 
alongside MIDI and Instrument tracks. 
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Working With Video & Creating Soundtracks/Broadcasts 
 
1 Pro Tools allows you to drag and drop any video straight into a session and start 
working with it. This section explores the idea of creating two extra tracks to go with it: a 
music soundtrack and a voiceover. This is ideal for teaching the idea of broadcasting 
and podcasting 
 
2 Start a new Pro Tools session. Create a mono audio track (for your voiceover). 
The other tracks will be chosen automatically in a minute. 
Locate two things you’ll need: some video and some pre-recorded audio (perhaps some 
“library music” or some music that could be appropriate to work with the video – of 
course you can create your own music too – see the other sections for instructions on 
that! Make sure both of these are close at hand on your computer’s hard drive or desktop. 
 
3 Drag the video into Pro Tools: you may get a dialog box appear when that 
happens  

 
On this occasion, you may NOT want to import the audio from the file, since you’re 
creating your own! You can also mix the video’s soundtrack with your own, of course. 
You’ll see a kind of a “story board” appearing against the timeline of the track. Click in 
the timeline (SMART TOOL should be selected, as well as SLIP mode: see other 
sections of this guide if you’re not sure about these things). You should also be able to 
drag the starting point of the video across the timeline of the song: make sure the hand 
tool appears for you to do this (hint: moving the mouse towards the bottom of the video 
track makes the hand appear). 
 
4 Now locate some audio on your hard drive: perhaps a song or existing stereo 
recording. This will at as your “soundtrack”. 
Drag the audio into Pro Tools; the audio file should automatically be detected as a stereo 
audio track (no need to create a blank track first). Make sure both the video and audio are 
located where you want them in the song: i.e. running simultaneously. 
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5 Open the mix window. You’ll notice that the video doesn’t have it’s own track 
slider, because it has no sound. Your stereo audio track should automatically be set to 
play through your hardware. Play the song to check. 
 
6 Now we’ll create a separate mono audio track for our voiceover, and learn how to 
cross-fade between the audio soundtrack and the voiceover. Create the track, rename it 
“voice”, connect a mic to your Mobile Pre or Ozone Academic, and activate phantom 
power (assuming the mic is a condenser requiring phantom power). You should open the 
mix window and find the track with its slider. Record-enable it and try speaking into it to 
check for a level. Listen through the headphones and adjust the input level of the mic on 
your Mobile Pre or Ozone Academic: you might notice a slight delay between speaking 
and hearing it back through your headphones: that’s called latency. The input selection 
for your voice track would most likely be input 1. The existing audio track doesn’t need 
an input source to be set, since we’re not planning to record any more on that track. Try 
recording a little voice over. 
 
7 Assuming the levels are good, you can record a little more later on in the track, so 
that the voiceover has several different parts to it (hint: simply move the smart tool to 
where you want to start recording, click on the song’s timeline, and start recording). 
When you’re done, de-enable the track from being ready to record. 
Your screen should look a little like this: 
 

 
 
 
8 Using Strip Silence: When doing voice only recording, it’s customary to remove 
all the silence when you’re not talking, to get rid of background noise and breath noises. 
Pro Tools can automate this for you using “Strip Silence”. Pull down your edit menu and 
go to “Strip Silence” (Shortcut Control U or ⌘-U on Mac ). The following box will 
come up. 
 

 
 
9 The control you should experiment with is the “threshold”. You need to set this so 
that your silence gets erased, so you’ll want this set relatively low. Set it too high, and 
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you may chop off the actual speech. If you make an error, you can always “undo” and try 
it again. 
 
10 This next section uses FADES and REGIONS, both of which are explained in 
the “Editing Existing Audio” section of this guide. 
To do a basic fade for any specific region, select the bit of audio during which you’d   
like the fade to happen, and type Control/⌘ F: don’t select the whole region: just the bit 
before the piece switches from soundtrack to voice over.  
Hint: when doing fades, it’s DEFINITELY a good idea to zoom in on the whole song: 
shortcut is Control/⌘ and the square brackets [ and ] on your computer. 
 
11 If you mistakenly separated two regions, highlight both sections and select “Heal 
Separations” from the edit menu (Shortcut Control/⌘ H). This will consolidate the break 
and “glue” your regions back together. 
 
12 If you’d like to better control the volume between two tracks, you’ll need to 
automate the volume level of the tracks. This is useful when the soundtrack needs to dip 
down to hear the voice more clearly. To do this, pleased refer to the section entitled 
“Mastering” in this document to learn about automation. 
 
One other technique: if you simply want the whole volume of the track to drop for a 
period of time, create a region split on either side, go to the track detail (left hand side), 
and click where it says WAVEFORM: change this to VOLUME 
 

 
 

13 Then as you move your smart tool cursor over the region whose volume you want 
to drop, you should see a solid black line. Hold your mouse over this, and it changes to 
the shape of a horizontal staple. Click and drag, and you’ll see the track’s volume go 
down. That’s for sudden drops in volume in a region. 
 
14 Learning how to do all these things gives you the chance to develop your own 
broadcasts. Try bringing in lots of different tracks of audio, and mixing them all with a 
voiceover, thus replicating documentaries or news items on TV.  
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The Basics of Mixing & Using Audio Plug-ins 
 
1 The most basic aspect of mixing is balance. We control the balance of our audio 
in two ways: front to back through volume changes and side-to-side through track 
panning. To bring an instrument into focus, use the fader in the mix window to balance 
its sound against the other tracks volume. This brings instruments into the foreground 
when needed and others into the background. Side to side panning is also very important. 
Think of an acoustic ensemble: each instrument comes from it’s own distinct place. By 
default, all new tracks in Pro Tools are panned dead center. You’ll want to adjust this to 
the right for to the left to create the illusion of a “sound stage” in your recording. Proper 
volume and pan changes can begin to refine a mix. Next, you’ll want some effects. 
 
2 Before you start to mix your song, it’s worth understanding how you can add 
effects to dramatically enhance the sound. You need to think about something called the 
signal path, because you have several choices about WHEN and WHERE to add effects 
like reverb, EQ, compression and delay/echo. You may need to deal with several tracks at 
once, and your computer may simply run out of gas if you wire things up incorrectly. 
 
3 Now there are several different kinds of effects! 
For more information about what each effect does, refer to your Pro Tools documentation 
or a reference guide about recording, e.g. the Everything Home Recording Book from 
www.everything.com.  
Compression and EQ should be added as an INSERT effect (more in a minute) because 
they shape the sounds of individual tracks. 
Reverb and delay/echo are different, because you are simulating (in a computer) how real 
sound reverberates, so these effects should be added to the mix in a different way than 
Compression/EQ – using AUX INPUTS (more below).  
 
4 Now take a look at the two diagrams below. 
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Diagram A (above) shows how you add INSERT effects (EQ, Compression) to a track in 
a Pro Tools session. 
You control the LEVEL of these effects very simply with a few mouse clicks. 
 

 
 
Diagram B (above) shows how you add effects like reverb and delay/echo to a track in a 
Pro Tools session, by SENDING part of the signal to an AUX INPUT. Unfortunately 
though, for this to work, you have to use an intermediate step, which is called BUSSING. 
A bus is simply a virtual cable that connects your channels together. More in a minute! 
 
5 Adding INSERT effects to recordings (compression, EQ) – see diagram A 
First create your recording! 
Then open the Mix window, where you can see your track(s) 
Then click on the topmost set of arrows in the channel strip (hovering over it with your 
mouse will tell you “Insert selector A”) 
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Choose Plug-in, and you’ll several choices: choose EQ>1-Band EQ 3 (mono) 
You have now added an insert effect to your track, and a window will appear with EQ. 
 

 
 
Play the track back and start experimenting with the buttons inside the EQ. 
Follow the same step to add compression: you can add more than one INSERT effect to a 
track. 
 
6 Adding AUX SEND effects to recordings (reverb & delay/echo) – see diagram B 
First create your recording!  
Then type Control + Shift + N (⌘ + Shift N on Mac), and create a new stereo Aux Input 
track. This will be used to control reverb and delay/echo in your song. Rename it if you 
like, with a name like REVERB. You may need to create a separate Aux Input track if 
you want delay/echo in your song as well. 
Now go to the Mix window (window>mix). Your audio track(s) will most likely be blue, 
and the new Aux Input track(s) will be green. 
 
7 On your audio track, move your mouse to send selector A, and select Bus>Bus 1-
2 (Stereo). A window will appear with a fader. That fader will control how much signal 
reaches the Aux Input track 
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8 Now change the INPUT on the Aux Input track by selecting the Audio input path 
selector and choosing bus>Bus 1-2 (Stereo). See picture below. This provides the 
essential link between your audio tracks and your Aux input track (as though you had 
physically wired them together). 
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9 Next, we add the effect desired to the Aux Input. Go to the INSERT area (at the 
top of the Aux Input strip) and choose Multi-channel Plug-in>Reverb>D-Verb (Stereo) 
You have now chosen the reverb to use in the song. 
If you also need to add delay/echo, you’ll repeat the same steps on the extra Aux Input 
channel you create, but use different buses, such as 3-4, so you can send signals from 
your tracks to two separate effects, using different buses. 
 
10 You’re ready to start experimenting with your song. 
Start playing the track. To add reverb, you need to send signal from your audio track to 
your bus. This is done by adjusting the bus fader, which is at zero by default. Raise the 
fader with your mouse. How much is up to your personal taste. You should see signal 
now appearing in the AUX input track, which you may have labeled “Reverb”. The fader 
on the AUX input track controls how much reverb is present in the mix. Raise and lower 
this to taste. In short, the bus track fader acts as a wet/dry mix (WET = lots DRY = 
nothing). The fader on the AUX input acts as a reverb master fader.    
 
11 If you are dealing with multiple tracks of audio that all need reverb on them, 
remember that each one needs to be sent to the SAME bus if you wish to use the SAME 
reverb on each track (which is highly recommended and is normal practice). 
 
12 Each track can have a different amount of signal sent to the AUX track. This is 
done via the bus fader for each individual track. If you’d like to check the effect on an 
individual track, simply “SOLO” using the “S” button on the individual audio track. 
As you start to explore effects, you’ll see lots of knobs and sliders. Don’t fear… Play 
with the settings until you find something you like! 
 
 
 
 
 
 
 
13 Window Management: As you start add more and more windows, your screen 
may start to look cluttered and you may even lose sight of a window or two. To gain 
control of your open windows, use the WINDOW pull down menu at the top of the 
screen to view all open windows. This is a real lifesaver if you’ve misplaced an important 
window, and need to get it back in view. The floating transport window is a commonly 
hidden floating window that’s perfect for these occasions.  
 

 
 

Pro Tip: 
When adding Reverb, if you can tell that the effect is present, 
you’ve added too much. It should not sound like Notre Dame 
Cathedral… Just add a little bit and flavor to taste.  
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Mastering a MultiTrack Finished CD 
 

Once you’ve gotten all your sounds together, you’ll need to finalize your mix, add some 
automation if you need it and bounce all your audio together into one stereo file suitable 
for sharing or burning onto a CD. 
 
1 External MIDI to Audio. If you’re triggering MIDI from a keyboard or some 
other external source, you’ll need to bring the audio into your Pro Tools file at the end. 
To do so: create a new audio track (probably stereo) and wire the outputs from just your 
MIDI source (physically with cables) into your MobilePre or Ozone. You need to send 
the audio from your module or keyboard into Pro Tools as AUDIO, not MIDI. Record-
enable the new track and press record/play and let your entire song play through. When 
you’re done, you can mute the original MIDI track. You’ll need to do this for all of your 
MIDI tracks that trigger external devices. 
 
2 Instrument Tracks. If you’re using XPand or another instrument track, Pro 
Tools will convert this to audio automatically for you when you go to export. You do not 
need to do anything special to these tracks. 
 
3  Automating Volume. In order to really control the balance of a mix, you’re 
going to want to explore some sort of “Automation”. Automation is simply the recording 
of actions with Pro Tools. You can use this to pre-record the movements of volume 
faders throughout your piece, for example. To do this, go to each track and change its 
display from “Regions” to “Volume” in the edit window 
 

 
 
Now, grab the pencil tool from the tool collection (upper left of the screen) and on the 
black line that is present on each track, you can add small “nodes” or “points” on that 
volume line to initiate a change in volume. Once you’ve added the points, go back to 
your SMART TOOL (or just the HAND tool will do), and move the points up and down 
to create volume changes. The type of cursor you’re looking for at this point is a hand 
with a pointing finger! This screenshot shows a section where four points were used to 
create a sudden volume change down for a short time and then back up again to the 
original volume. 
 
There is no limit to how many points of automation you can add. When you play back 
your file, the faders will move by themselves based on where you’ve added these points. 
Refer to the documentation that came with your Pro Tools system if you’re interested in 
automating more than just volume. As an alternative, you can record the movement of 
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your faders with a mouse as well, please refer to your documentation for more 
information on “Recording Automation”. 
 
4 Final Levels.  Once you’ve recorded and mixed all your tracks to your liking, you 
should create a master fader. All the tracks’ output will automatically be sent to that, 
assuming they are active and not muted. Do so the same way you create any new tracks. 
On the newly created master fader, go to the Mix window and watch your track play 
back. Pay special attention to the level bar on the master fader. In order for you music to 
be clearly heard, it needs to have sufficient level. It can’t exceed 0dB, but it should come 
as close as possible. If your track is very low, you can add a plug-in to that master fader, 
called a “Limiter”, which is listed as “Compressor/Limiter/Dyn3” in your included plug-
in list. There are a few presets that are good starting points. Access them here: 
 

 
 
Use the “gain” control to add overall volume, but don’t go crazy with it! It starts to sound 
bad when too much limiting is used. 
 
 
 
 
 
 
 

Note: A limiter is a device that limits the dynamic peaks on an audio file. This is changing 
the natural character of your audio and enhancing the overall volume at the expense of 
natural dynamics. Classical/Acoustic music may be lower in volume by nature and adding 
a limiter will make the music sound very “squashed” and artificial. 
Let your ears be the final guide as to how much limiting to use – louder is not always 
better. 



Pro Tools Quick Start Guide: April 2007 34 

5 Bounce. The process of creating a final mix in Pro Tools is called a “Bounce”. 
Once your song sounds exactly the way you want and you’re happy, go to the “File” 
menu and “Bounce -> To Disk”. The following box will appear. 
 

 
 
These options are very important. Choose your settings to mirror the screenshot above 
exactly. This will result in a file that you can add to iTunes (or your preferred CD 
Burning method) and burn to an Audio CD.  
Pro Tools cannot burn a CD directly; make sure that you bounce each song individually if 
you’re working with multiple files and burn them in a separate program.  
 
 

Customizing the Interface of Pro Tools Academic 
 
The interface of Pro Tools is fairly flexible and you can change certain aspects of it to 
suit your personal workflow.  
 
1 Timeline/Rulers: The timeline of Pro Tools can display a multitude of views, 
many of which you may not need to see. To control what the timeline displays, go to the 
View > Rulers menu and select or deselect any items you don’t need in your session. This 
will free up valuable screen real estate for other tracks in your project. 
 
2 Tracks and Region List: You can make a track “inactive” if you’re not using it, 
this is very useful if you need more CPU power or a track is being used as a guide. Do 
make a track inactive, select the track, go to the “Tracks” menu and select “Make 
Inactive”.  
The region list shows all of the regions in your session (whether they’re in use or not). To 
show the region list, open your edit window and look at the bottom right corner of the 
screen. You will see a pair of arrows facing left. Click on the arrows to reveal the region 
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list. Click the arrows again to hide it. You can resize the horizontal size of the Region 
List by dragging the vertical bar at the left edge of the window. 
 
3 Colors: Colors are very important when working in Pro Tools and can save you a 
great deal of time. Many users color-code their tracks. Red for drums, etc… To change 
the color of a track, go to the tracks far left edge in the edit window (a small slice of color 
appears) and click on the color to bring up a window for changing the track color. Set it 
to whatever color makes you happy. 
 
4 Screen Layout: The “View” menu is your one stop for changing the aesthetic of 
Pro Tools. Make sure you explore this menu. Pro Tools is generally a two-window 
application: Mix and Edit windows. If you have a small monitor, you won’t be able to 
easily view both windows at the same time. Remember your shortcuts for calling up your 
windows; they’re very helpful in this regard. You can also resize any of the windows in 
Pro Tools. It’s possible to have a small mix and small edit window side by side. You can 
always scroll through a large window using the scroll bars. If you have the luxury of two 
monitors, you can drag the edit window to one monitor and the mix window to the other. 
 
5 Routing in Edit: To change input and output assignments, including setting p 
sends and busses in Pro Tools, you typically have to go to the Mix window. You can 
configure the Edit window to show all of the details of the Mix window by tweaking the 
View>Edit Window and selecting “ALL”. While the screen may get a bit crowded, you’ll 
see all the information in one place. This way you’ll only need to venture to the Mix 
window to actually “Mix”. 
 
6  Resolution: Always make sure that your computers monitor is at its highest 
resolution; otherwise screen elements may become “blurry”. Remember that all your 
visual elements in Pro Tools can be zoomed in for more detail.  
 
7 Mix Notes: In the mix window, directly below your fader is a small grey area set 
aside for track notes. Click in the empty space to bring up a text box. This is handy for 
saving notes about the track, the microphones used, and other important details. 
 
8 If you’re creating a lot of tracks in your score, you may also wish to narrow the 
width of each track’s fader on the mix view. Make sure your mix window is at the front 
of your session, then go to View>Narrow Mix, or type Control/Alt M (/⌘-Opt M on 
Mac), and each track will get narrower. Use the same shortcut to widen them again. 
 
9 Saving Practices: A good rule of thumb: Save incrementally to avoid data loss. 
Each time you save, always “Save As” and save each project with a new name. A good 
idea is to use the date and time in the name or at least, something that will increment. For 
example: Prelude-3:15 or Prelude-1. Each time you resave, give it a new name. You will 
have more files on your hard drive, but in the unlikely event of data loss, you’ll have lots 
of files to try to open.  
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Some Basic Shortcuts in Pro Tools Academic 
For a complete list, refer to the pdf documentation that comes with Pro Tools Academic 

Windows shortcuts are given, followed by Mac shortcuts 
 
Shift + Tab     extend selection (if point in track is selected) 
Control = / ⌘ =    bring mix window to front 
Control/⌘ [ or ]    zoom in horizontally on session 
Control-Alt ] or [ / ⌘-Opt ] or [  zoom in vertically on audio data 
Control-Shift ] or [  /⌘ Shift ] or [  zoom in vertically on MIDI data 
 
Alt R / Option R    Repeat a section of audio 
 
Control 1 / ⌘ 1 (main numbers)  activate floating transport window 
Control 7 / ⌘ 7 (main numbers)  activate Smart Tool 
Control E / ⌘ E    create a region 
Control F / ⌘ F    create a fade   
Control H / ⌘ H    glue together two regions 
Control M / ⌘ M    mute/unmute a selected region 
Control N / ⌘ N     start a new session 
Control O / ⌘ O    open a session 
Control W / ⌘ W    bring edit window to front 
Control U / ⌘ U    create strip silence on an audio track  
 
Control-Alt L / ⌘-Opt L   loop a selected region 
Control-Alt M / ⌘-Opt M   narrow/widen the Mix view window 
Control-Shift N / ⌘ Shift N   create new track 
Control Shift W / ⌘ Shift W   close a session 
Alt 1 / Option 1 (numeric keypad)  time signature 
Alt 2 / Option 2 (numeric keypad)  tempo 
Alt 3 / Option 3 (numeric keypad)  quantize 
 
Alt/Option 1,2,3,4 (main numbers)  choose MODE (shuffle, spot, slip grid) 
F1, F2, F3, F4 keys    choose which mode 
 
Alt = / Option =    open/close MIDI event editor   
0 on numeric keypad    play track from song position 
1 on numeric keypad    rewind  
2 on numeric keypad    fast forward 
3 on numeric keypad    record (if tracks are enabled) 
4 on numeric keypad    loop playback (between locate points) 
5 on numeric keypad    loop record 
Minus/plus keys (numeric keypad)  nudge selected audio to the right or left 
Enter key (numeric keypad)   add a marker, if a point in a region is chosen 
Enter/Return (QWERTY keyboard)  Return cursor to beginning of song 


